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ВВЕДЕНИЕ

Главная задача промышленности состоит в динамичном, пропор-
циональном  развитии общественного производства и повышения его 
эффективности, ускорении научно-технического прогресса (НТП), ро-
ста производительности  труда, улучшения качества продукции. 

Рост существующих и  появление  новых отраслей промышленно-
сти вызывает, в свою очередь, необходимость дальнейшего развития 
системы высшего и  среднего специального образования, повышения 
качества подготовки молодых специалистов для всех отраслей промыш-
ленного производства. Задача  подготовки   высококвалифицированных   
кадров, вооруженных современными  знаниями, практическими навы-
ками, является одной из важнейших. Остро ощущается необходимость 
приложения максимальных усилий для совершенствования содержа-
ния обучения, средств и методов подготовки специалистов. Выполне-
ние учащимися лабораторных работ является важным средством более 
глубокого усвоения и изучения учебного материала, а также  приобре-
тения практических  навыков по экспериментальным исследованиям.

 В настоящих методических указаниях приведены описания ше-
сти лабораторных работ по учебному курсу «Основы проектирования 
телекоммуникационных систем и сетей» для студентов четвертого кур-
са специальности 210405 «Радиосвязь, радиовещание и телевидение» 
и учебному курсу «Основы проектирования инфокоммуникационных 
систем и сетей» для студентов третьего курса направления 210700 «Ин-
фокоммуникационные технологии в системах связи».

Курс лабораторных работ посвящается изучению принципов функ-
ционирования некоторых видов телекоммуникационного оборудова-
ния. Лабораторные работы проводятся в среде LabView. Это позволяет, 
с одной стороны, достаточно адекватно макетировать работу требуе-
мых узлов и блоков, а с другой – изменять параметры как исследуемых 
узлов, так и виртуальных измерительных приборов в пределах, недо-
стижимых на имеющемся лабораторном оборудовании.

Использование при разработке современного телекоммуникацион-
ного оборудования возможностей моделирования с помощью виртуаль-
ных средств в настоящее время находит все более широкое применение.



4

Лабораторная работа № 1

ОЗНАКОМЛЕНИЕ С МЕТОДИКОЙ ИСПОЛЬЗОВАНИЯ 
СРЕДЫ LabView

Цель работы
Ознакомиться с методикой программирования в среде LABVIEW на 

примере создания виртуальных генераторов и измерительных приборов.

Краткие теоретические сведения
Программная система LabView – удобное средство для проекти-

рования измерительных каналов, приборов, систем. Она обеспечива-
ет построение и моделирование измерительных структур различной 
сложности. Система имеет библиотеку виртуальных модулей (моде-
лей) измерительных средств, их отдельных блоков и компонентов. Она 
позволяет пользователю создавать виртуальные измерительные при-
боры любой сложности и формировать свою библиотеку виртуальных 
средств (VI). Система обладает удобными средствами редактирования 
и отладки и обеспечивает работу с реальными измерительными прибо-
рами, модулями и сигналами.

Создание виртуального измерительного средства связано с опреде-
лением его измерительной функции, созданием лицевой панели с ор-
ганами управления и средствами представления данных, созданием 
структурной схемы, выполняющей заданную измерительную функ-
цию, редактированием и отладкой работы измерительного устройства. 
Для этого система поддерживает соответствующие режимы: создание 
лицевой панели измерительного прибора – Panel, создание структур-
ной схемы и отладка работы – Diagram.

Каждый режим имеет свое окно, панель управления и поддержи-
вается библиотекой (палитрой) моделей функциональных блоков (вир-
туальных модулей).

Методика изучения: в качестве источника сигнала будут исполь-
зоваться генераторы прямоугольных импульсов (ГПИ), треугольных 
импульсов (ГТИ), синусоидальных сигналов (ГС) и шумоподобных 
сигналов (ГШС). Предусмотрена возможность ручной регулировки ам-
плитуды, длительности и задержки импульса. Сигнал генератора будет 
отображаться на графическом индикаторе. Результат анализа – спек-
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тральная плотность мощности – будет наблюдаться с помощью второго 
графического индикатора. С помощью третьего индикатора будет фик-
сироваться сигнал после прохождении через фильтр. Процесс програм-
мирования ведется пошагово с подробным разъяснением каждого шага.

Создание лабораторной установки

Для создания нового виртуального прибора (ВП) нужно активизи-
ровать лицевую панель ВП. Для этого необходимо:

1. Запустить LabVIEW – дважды щелкнуть мышью иконку Lab-
VIEW на рабочем столе Widows или выбрать Пуск Программы Lab-
VIEW;

2. В появившемся диалоговом окне LabVIEW щелкнуть кнопку 
New (Новый);

3. Выбрать New => Blank VI (последовательно щелкнуть команды 
меню New и Blank VI). При этом откроется лицевая панель ВП, как по-
казано на рис. 1.1.

Рис. 1.1. Фрагмент лицевой панели при создании нового ВП

На фоне серой лицевой панели одновременно появляется палитра 
рабочих инструментов Tools.

4. Желательно перед началом работы нарисовать на бумаге блок-
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схему создаваемого прибора в традиционном понимании. Это позволит 
избежать многих ошибок и намного облегчить в последующем процесс 
графического программирования, поскольку запись программы прак-
тически будет совпадать с блок-схемой. Блоки прибора обозначаются 
прямоугольниками, а входы и выходы – стрелками. Управляющие вхо-
ды генератора импульсов помечаются соответственно Амплитуда (Де-
виация), Длительность (Повтор), Задержка (Нач. фаза. Нач. число).

5. Переходим к графическому программированию. Создание ВП 
следует начинать с лицевой панели. Если на экран выведено окно блок-
схемы, переключиться на лицевую панель можно, выбрав из меню па-
нели управления окна Window => Show Front Panel.

6. Из меню в верхней строчке окна лицевой панели выбрать View => 
Controls Palette и View => Tools Palette, чтобы вывести на экран пали-
тры Controls (Органы управления) и Tools (Инструменты).

7. Из палитры Tools выбрать инструмент Действия «Рука», если до 
этого он не был выбран.

8. Из подменю Modern палитры Controls выбрать Graph, затем 
графический индикатор (Waveform Graph) для отображения сигнала и 
перенести его на лицевую панель. Разместить его справа наверху лице-
вой панели. В появившейся метке можно тут же с клавиатуры ввести 
название индикатора «Сигнал».

Чтобы закончить ввод метки, нажать на кнопку <Enter>  в левом 
верхнем углу окна или щелкнуть мышью в любом незанятом месте ли-
цевой панели. Если вы не ввели текст в метку, то название метки сохра-
нится по умолчанию – Waveform Graph. Метку можно снова вызвать, 
установив инструмент Действия или Позиционный инструмент  на 
индикатор, нажав правую кнопку мыши и выбрав из появившегося объ-
ектного меню Visible Items => Label (Метка).

9. Если необходимо отредактировать уже созданную метку объ-
екта, то она выбирается из палитры Tools Меточный инструмент (в 
палитре – кнопка с буквой «А») и после подведения к существующей 
метке необходимо щелкнуть мышью, после чего в поле метки поя-
вится курсор. Можно ввести текст метки и завершить его нажатием 
кнопки <Enter> в левом верхнем углу окна. Так же можно изменить 
размер и тип шрифта с помощью окна шрифта, которое расположено 
вверху окна лицевой панели или блок-схемы.

10. Второй графический индикатор для наблюдения спектра выби-
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рается аналогично п. 8. Поместить индикатор на лицевой панели ниже 
первого индикатора. Ввести в метку его название «Спектр» и повто-
рить для него действия п. 9. Ввести метку «Частота», заменив суще-
ствующую метку «Time». Вызвать объектное меню этого индикатора и 
снять в нем выделение с опции X Scale => AutoScaleX. Этим действи-
ем выключается автоматическое масштабирование оси X графическо-
го индикатора. С помощью Меточного инструмента ввести конечное 
значение горизонтальной шкалы, равное 50. Необходимо помнить, что 
градация шкалы X в этом примере проведена в условных единицах.

11. При желании можно изменить положения индикаторов на ли-
цевой панели и их размеры. Для этого необходимо выбрать из пали-
тры Tools опцию Позиционный инструмент («Стрелка») , выделить 
объект, щелкнув на нем левой кнопкой мыши, а затем, нажав и удержи-
вая левую кнопку мыши, можно переместить его в любое место. Что-
бы изменить размер объекта, необходимо подвести Позиционный ин-
струмент к любому углу объекта и изменять размер объекта, переме-
щая мышь при нажатой левой кнопке. Однако в этом ВП изменения 
размеров элементов лицевой панели не требуется. Можно удалить не-
нужный объект, выделив его и нажав клавишу <Del>. Но нельзя уда-
лить отдельные части объектов, например собственную метку объекта, 
цифровой дисплей числового органа управления и т. д. Однако можно 
убрать их изображение с экрана, вызвав объектное меню и сняв выде-
ление с опции Visible Items => Label (чтобы убрать метку) или Visible 
Items => Digital Display (чтобы убрать цифровой дисплей).

12. Из подменю Numeric палитры Controls (Modern→Numeric) вы-
брать три вертикальных ползунковых регулятора (Vertical Pointer Slide) 
для регуляторов Амплитуда (Девиация), Длительность (Повтор) и 
Задержка (Нач. фаза. Нач. число), разместить их на лицевой панели 
слева от индикаторов сверху вниз и ввести их названия в метки. С по-
мощью Меточного инструмента изменить верхние числовые значе-
ния на шкале регуляторов «Длительность» и «Задержка» на величины, 
равные 100 и 200 соответственно.

13. Можно выровнять объекты лицевой панели (или блок-схемы) 
по какой-либо оси, а также более равномерно распределить их на ли-
цевой панели. Для этого необходимо Позиционным инструментом вы-
брать подлежащие выравниванию объекты и одну из опций в окнах 
Align Items (Выравнивание объектов) и/или Distribute Items (Распреде-
ление объектов) (Edit→…).
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14. Выбрать несколько объектов можно двумя способами. Во-
первых, можно нажать левую кнопку мыши с Позиционным инструмен-
том в свободном месте лицевой панели и, не отпуская кнопки, переме-
стить мышь так, чтобы появившийся прямоугольник выбора содержал 
только те объекты (хотя бы частично), которые требуется выбрать, а за-
тем отпустить кнопку. Во-вторых, можно выбирать объекты по одному, 
удерживая нажатой клавишу <Shift> и щелкая мышью с Позиционным 
инструментом на каждом из объектов.

15. Можно изменить цвет лицевой панели или ее индикаторов и ор-
ганов управления. Для этого надо выбрать из палитры Tools Цветовой 
инструмент («Кисть»)  и, установив его рабочий конец на какой-
либо объект, нажать правую кнопку мыши. Появится цветовая палитра, 
из которой можно выбрать любой цвет, нажав на нем правую кнопку 
мыши. Рекомендуется окрасить рамки индикаторов, ползунки регуля-
торов и кнопку «Stop» в цвета немного темнее фона лицевой панели.

16. Разместив индикаторы и органы управления на лицевой пане-
ли, можно перейти к блок-схеме. Чтобы сделать это, надо выбрать в 
меню Window => Show Block Diagram. На блок-схеме вы увидите пря-
моугольные терминалы, соответствующие органам управления и инди-
каторам лицевой панели. Терминалы окрашены в оранжевый цвет и 
имеют те же метки, что и соответствующие им объекты лицевой пане-
ли. Обозначения на терминале определяют тип данных, используемых 
в элементах управления или отображения. Например, обозначение DBL 
(double) определяет, что данный терминал использует числа двойной 
точности с плавающей запятой. Для облегчения монтажа блок-схемы 
и увеличения ее наглядности рекомендуется разместить терминалы 
органов управления слева, а терминалы индикаторов – справа, оста-
вив между ними место для размещения других элементов блок-схемы. 
Можно разместить их в окне блок-схемы, а также выровнять и распре-
делить более равномерно аналогично тем же операциям для объектов 
лицевой панели с помощью Позиционного инструмента. Однако нель-
зя изменять размеры терминалов, некоторых функций на блок-схеме, 
а также менять их цвет. Нельзя также удалять терминалы индикато-
ров и органов управления лицевой панели на блок-схеме. Для удаления 
какого-либо терминала необходимо удалить соответствующий ему объ-
ект лицевой панели.

17. Чтобы вывести на экран палитру Functions (Функции), надо ее 
выбрать из меню View => Functions Palette.
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18. Из подменю Numeric палитры Functions (Programming→ Nu-
meric) выбрать числовую константу (Numeric Constant) и поместить ее 
на блок-схеме выше терминалов органов управления. С помощью Ме-
точного инструмента ввести в константу значение, равное 800. Этой 
константой задается количество точек (отсчетов) для отображения пря-
моугольного импульса. По умолчанию это число равно 128. Следует 
обратить внимание на то, что эта константа может иметь только цело-
численное значение. Проводники, по которым передаются целочислен-
ные величины, окрашены в синий цвет.

19. Из палитры Functions выбрать подменю Signal Processing, а из 
него – Signal Generation. Из этого подменю выбрать один из генераторов 
и поместить его на блок-схеме справа от терминалов органов управления:

– генератор прямоугольного импульса (Pulse Pattern.vi);
– генератор синусоидального импульса (Sine Pattern.vi);
– генератор треугольного импульса (Triangle Pattern.vi);
– генератор белого шума (Uniform White Noise.vi);
– генератор гауссова шума (Gaussian Noise.vi).
20. Из подменю Signal Processing выбрать подменю Spectral Anal-

ysis. Из него выбрать вычислитель спектра мощности Power Spectrum.
vi и поместить его на блок-схеме между генератором и терминалами 
индикаторов.

21. Из палитры Tools выбрать Монтажный инструмент («Катушку»). 
После этого можно приступить к монтажу блок-схемы, то есть к соедине-
нию между собой терминалов органов управления, функций, констант и 
индикаторов. Для того чтобы соединить между собой два терминала (или 
подключить их друг к другу), необходимо установить «Катушку» на пер-
вый терминал (при этом он должен высветиться). После этого требуется 
щелкнуть левой кнопкой мыши, а затем, перемещая «Катушку» (при пе-
ремещении за ним тянется пунктирный провод, который можно согнуть 
в любом месте, щелкнув левой кнопкой мыши), установить его на другой 
терминал (который также должен высветиться) и снова щелкнуть левой 
кнопкой мыши. При этом два терминала будут соединены проводом опре-
деленного цвета, зависящего от типа передаваемых данных. Неправильно 
установленный провод или его участок можно удалить нажатием клавиши 
<Del>, предварительно его выбрав. Чтобы выбрать провод или его уча-
сток, щелкните на нем левой кнопкой мыши Позиционным инструментом 
(«Стрелкой») один раз (выбирается участок провода между двумя сгиба-
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ми), два раза (выбирается участок провода между двумя подключениями) 
или три раза (выбирается весь провод). Можно подключиться к уже суще-
ствующему проводу. Для этого устанавливается индикатор «Катушка» на 
провод так, чтобы он обесцветился, и щелкается левая кнопка мыши.

22. Подключить числовую константу к терминалу выбранного ге-
нератора «samples».

23. Подключить терминал регулятора Амплитуда (Девиация) к тер-
миналу выбранного генератора «amplitude» ( «standard deviation») для 
генератора гауссова шума.

24. Подключить терминал регулятора Задержка (Нач. фаза. Нач.
число) к терминалу выбранного генератора:

– «delay» для генераторов прямоугольного треугольного и импуль-
сов;

– «phase» для генератора синусоидального импульса;
– «seed» для генераторов белого и гауссова шума.
25. Подключить терминал регулятора Длительность (Повтор) к 

терминалу выбранного генератора:
– «width» для генераторов прямоугольного и треугольного им-

пульсов;
– «cycles» для генератора синусоидального импульса;
для генераторов белого и гауссова шума этот терминал не нужен.
26. Подключить выходной терминал генератора прямоугольного 

импульса «Pulse Pattern» к входному терминалу вычислителя спектра 
мощности «X».

27. Подключить выходной терминал вычислителя спектра мощно-
сти «Power Spectrum» к терминалу индикатора «Спектр».

28. Подключить терминал индикатора «Сигнал» к проводу, соеди-
няющему выходной терминал генератора и входной терминал вычис-
лителя спектра мощности.

29. На этом монтаж блок-схемы закончен. Теперь при необходи-
мости можно дополнительно отредактировать блок-схему, чтобы избе-
жать возможных наложений элементов блок-схемы и нежелательных 
пересечений проводов в целях повышения наглядности блок-схемы.

Фильтрация сигналов

В палитре Filters (Фильтры) размещены линейные цифровые филь-
тры Баттерворта, Чебышева, Бесселя, Кауэра. Нелинейная фильтра-
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ция представлена медианным фильтром. Функция фильтрации разме-
щена в основной палитре Filters (Signal Processing→ Filters), а также 
в дополнительных палитрах Advanced IIR Filtering и Advanced FIR 
Filtering-фильтры с бесконечной импульсной характеристикой (БИХ) 
и фильтры с конечной импульсной характеристикой (КИХ).

На входах фильтра задаются тип фильтра (fi lter type) и его параме-
тры (частоты среза, порядок, коэффициенты БИХ- и КИХ-фильтров, 
неравномерность в полосе затухания и т. д.). Тип фильтра задается 
цифрой (0 – ФНЧ, 1– ФВЧ, 2 – полосовой, 3 – режекторный фильтр).

Создание фильтра

Создадим фильтр Бесселя, через который будет проходить иссле-
дуемый сигнал. Воспользуемся методикой, приведенной выше.

30. Из подменю Graph палитры Controls (Modern→Controls→ 
Graph) выбрать графический индикатор (Waveform Graph) для отобра-
жения сигнала и перенести его на лицевую панель. Разместить его ниже 
других индикаторов  лицевой панели. В появившейся метке можно тут 
же с клавиатуры ввести название индикатора «Фильтр».

31. Из подменю Numeric палитры Controls (Modern→Numeric) вы-
брать четыре вертикальных ползунковых регулятора (Vertical Pointer 
Slide) для регуляторов «Тип фильтра», «Верхняя частота среза», «Ниж-
няя частота среза» и «Частота дискретизации», разместить их на лице-
вой панели слева от индикаторов сверху вниз и ввести их названия в 
метки. С помощью Меточного инструмента изменить верхние число-
вые значения на шкале регуляторов на необходимые.

32. Чтобы отредактировать уже созданную метку объекта или вы-
ровнять объекты лицевой панели (или блок-схемы) по какой-либо оси, 
а также более равномерно распределить их на лицевой панели, можно 
воспользоваться методикой, приведенной в пп. 9 и 13.

33. После этого перейдем к блок-схеме. Из палитры Functions не-
обходимо выбрать подменю Signal Processing, а из нее – Filters. Из 
этого подменю выбрать фильтр Бесселя (Bessel Filtеr.vi) и поместить 
его на блок-схеме справа от терминалов органов управления.

34. Из палитры Tools выбирается Монтажный инструмент («Ка-
тушка»). Теперь можно приступить к монтажу блок-схемы, то есть к 
соединению между собой терминалов органов управления, функций, 
констант и индикаторов.

35. Подключить терминалы регуляторов «Тип фильтра», «Верхняя 
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частота среза», «Нижняя частота среза» и «Частота дискретизации» к 
соответствующим терминалам «Bessel Filtеr»: «Filter type», «high cutoff 
freq fh», «low cutoff freq fl», «sampling  freq fs».

36. Подключить выходной терминал «Bessel Filtеr» к терминалу 
индикатора «Фильтр».

37. Подключить выходной терминал выбранного генератора к вход-
ному терминалу «Bessel Filtеr» «X».

На этом монтаж блок-схемы закончен.
38. Перейти в окно лицевой панели и запустить ВП, нажав кнопку 

«Пуск» (Run) в левом верхнем углу. Манипулируя регуляторами, про-
смотреть на экране индикатора прямоугольный импульс и спектр мощ-
ности для различных значений параметров импульса.

39. Для сохранения созданного ВП выбрать в меню File => Save 
(Save All, Save with Options). Ввести имя ВП, например Анализатор 
спектра. Сохранить ВП можно в виде отдельного файла или в виде 
группы из нескольких ВП в файл библиотеки ВП LabView с расшире-
нием *.lib. Вид блок-схемы и лицевой панели созданного виртуального 
прибора показан на рис. 1.2 и 1.3.

Рис. 1.2. Структурная схема установки
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Задание

1. Создать генератор прямоугольных импульсов (ГПИ) амплитудой 
5В, длительностью 50 с, задержкой 10 с. Пропустить данный сигнал 
через фильтр Баттерворта (тип фильтра и его параметры считать 
произвольными).

2. Изменяя частоту сигнала, проследить изменение его амплитуды 
на выходе фильтра и изменение формы спектра.

3. Рассмотреть, как меняется форма сигнала при изменении 
параметров фильтров.

4. Зарисовать все полученные графики и диаграммы.
5. Исследовать построение других видов генераторов ( ГТИ, 

ГШС, ГС – по заданию преподавателя) с различными параметрами 
генерируемых сигналов.

Содержание отчета
1. Краткая теория.
2. Структурная схема.
3. Осциллограммы.
4. Выводы.

Рис. 1.3. Итоговая Front Panel
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Контрольные вопросы
1. Что позволяет сделать программная система LabView?
2. Какие режимы поддерживает ПС?
3. Лицевая панель ВП: определение, назначение.
4. Возможно ли изменение размеров и положения объектов на 

лицевой панели?
5. Возможно ли изменение размеров и положения объектов на блок-

схеме?
6. Как вынести на экран палитры Controls и Tools?
7. Как создать и отредактировать метку?
8. Как можно выровнять объекты и равномерно распределить их на 

лицевой панели?
9. Как перейти от лицевой панели к блок-схеме и наоборот?

10. Что определяет обозначение DBL?
11. Как соединить между собой элементы блок-схемы?
12. Как запустить работу ПС и снять результаты?
13. Как изменяется сигнал на выходе фильтра в зависимости от 

характеристик фильтра?
14. Какие типы фильтров могут задаваться на входе фильтра и как 

это делается?
15. Какие фильтры можно выбрать в палитре Filters? Их различия.
16. Какие типы виртуальных генераторов можно создавать и как 

устанавливаются параметры генерируемых сигналов?
17. Какие типы измерительных приборов можно создавать и как 

устанавливаются их характеристики?

Лабораторная работа № 2

ИССЛЕДОВАНИЕ РЕЗИСТИВНО-ДИФФЕРЕНЦИАЛЬНОЙ 
СИСТЕМЫ

Цель работы
Создать виртуальный прибор резистивно-дифференциальной си-

стемы (РДС) в виде наглядной графической блок-схемы, приобрести 
навыки измерения основных параметров исследуемого виртуального 
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прибора (обеспечение развязки, равновесия моста), обработать резуль-
таты измерений, проанализировать данные.

Краткие теоретические сведения
Как известно, развязывающие устройства (РУ) делятся: 
– на линейные устройства на пассивных элементах (пассивные) – 

устройства, параметры которых не меняются по времени и не зависят 
от уровня сигналов;

– линейные активные развязывающие устройства –  устройства, 
собранные на активных элементах, параметры которых не зависят от 
времени, но их можно сделать зависимыми от уровня сигнала;

– параметрические развязывающие устройства – устройства, па-
раметры которых от сигнала не зависят, но характеристики некоторых 
элементов могут зависеть от времени;

РУ называются обратимыми или взаимными, если выполняются 
следующие условия:

А11-22=А22-11;
А44-11=А11-44.

Линейные пассивные развязывающие устройства всегда взаимны. 
В других РУ это условие может не выполняться, такие развязывающие 
устройства необратимы.

Из линейных пассивных развязывающих устройств используются, 
как правило, два вида:

1) резистивно-дифференциальные (РДС) – системы на основе ре-
зисторов.

2) трансформаторно-дифференциальные (ТДС) – системы на осно-
ве трансформаторов. 

Различные способы начертания схемы РДС приведены на рис. 2.1. 
Рассмотрим схему моста на рис. 2.2. Напряжения в точках a и b 

определяются как
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Из данной схемы следуют несколько важных выводов, которые ха-
рактеризуют работу РДС:

1. В случае, если мост уравновешен, то Ua = Ub, а значит, U2 = 0 при 
любом U1.

2. Поскольку разность потенциалов между точками a и b равна 
нулю, то между этими точками  можно поставить резистор любого но-
минала (рис. 2.2) при этом всегда будет обеспечиваться развязка. 

Такой мост также обеспечивает развязку в обе стороны между точ-
ками с и d, благодаря этому РДС нашли широкое применение в сред-
ствах телекоммуникации.

Рис. 2.1. Варианты начертания схемы РДС
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Схема называется сбалансированной и уравновешенной, если

Рис. 2.2. К расчету параметров РУ

Z1Z3 =ZаZb,                   .

Резисторы Z1, Z3, Za, Zb называются 
плечами мостовой схемы.

Направления 2–2, 4–4 называются 
диагональю.

Пусть Z1 = Z2 = Z3 = Z4 = Z, Zа = ηZ, 
Zb = Z/η,
где  Z – характеристическое сопротив-
ление линии передачи, η – некоторый 
коэффициент.

Если все эти условия выполняют-
ся, то РДС называется равноплечная.

В идеальном варианте  в направ-

Рис. 2.3. Направления прохождения 
сигналов

вения сигнала, т. е. именно эти 
направления взаимно развязаны. 
(Направления прохождения сиг-
налов указаны на рис. 2.3).

Исходя из величины Z вы-
бираются значения параметров 
РДС. Чтобы имело место согласо-
вание, необходимо, чтобы вход-
ное сопротивление со стороны 
разъемов 2-2 было равно характе-
ристическому сопротивлению Zc.
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Создание лабораторной установки

Рис. 2.4. Схема РДС, исследуемая 
в лабораторной работе

Узел 1-й: Y6E=(Y1+Y2+ Y3)U1–Y2U2–Y1U4.
Узел 2-й: 0=(Y2+Y5+Y3)U2–Y2U1–Y5U4.
Узел 4-й: 0=(Y1+Y2+Y4)U4–Y1U1–Y5U2,

              1           1           1           1           1           1где Y1 = Z1
, Y2 = Z2

, Y3 = Z3
, Y4 = Z4

, Y5 = Z5
, Y6 = Z6.

Отсюда напряжения в узлах 2 и 4

U2 = E Y6[Y2(Y1+Y4)+(Y1+Y2)Y5],N

U4 = E Y6[Y1(Y2+Y3)+(Y1+Y2)Y5],N
где

N = Y5[(Y1+Y2)(Y3+Y4)+Y6(Y1+Y2+Y3+Y4)]+Y1Y4(Y2+Y3)+Y2Y3(Y1+Y4)+
+Y6(Y1+Y4)(Y2+Y3)+Y2Y3(Y1+Y4)+Y6(Y1+Y4)(Y2+Y3),

Е – напряжение питания, поступающее с генератора.

Порядок действий при создании виртуального прибора:

1. В режиме Front Panel из подменю Numeric палитры Controls 
(Modern→Numeric) выбрать Numeric Control – 6 раз.  Ввести в метки 
их названия: «R1», «R2», «R3», «R4», «R5», «R6».

2. Для перевода сопротивлений в проводимости:
– из подменю Numeric палитры Controls (Modern→Numeric) вы-

брать Numeric Indicator – 6 шт. Ввести в метки их названия «Y1», 
«Y2», «Y3», «Y4», «Y5», «Y6»;

Используя программ-
ную среду LabView, сле-
дует воссоздать схему, 
изображенную на рис. 2.4. 
С помощью виртуальной 
лабораторной установ-
ки планируется изучать 
основные свойства РДС. 

С помощью мето-
да узловых потенциалов 
определяются напряже-
ния в узлах схемы:
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– перейти в режим Block Diagram;
– выбрать шесть математических функций Reciprocal (1/х) (Functio

ns→Mathematics→Numeric→Reciprocal);
– из палитры Tools выбрать монтажный инструмент «Катушка»;
– соединить выходы R1 – R6 с входами математических функций 

Reciprocal;
– соединить выходы математических функций Reciprocal с входами 

Y1–Y6.
3. Для создания блока расчета узлов U2 и U4 и задания коэффици-

ента N из палитры (Functions→Express→Arithmetic Comparison)  вы-
брать 3 панели Formula. При этом автоматически открывается поле 
для задания формулы (рис. 2.5).

Рис. 2.5. Поле для задания формулы

ка» соединить
– панели-индикаторы Y1, Y2, … Y6 с соответствующими входами 

Y1, Y2, … Y6 блоков – формул;
– выход Result блока – формулы N со входами N блоков-формул  

U2, U4.  
6. Необходимо вернуться на лицевую панель. Чтобы сделать это, 

надо выбрать в меню Window => Snow Front Panel.
7. Из подменю Numeric палитры Controls (Modern→Numeric) вы-

брать Dial – 2 шт. Ввести в метки их названия: «Амплитуда Е, В», «Ча-
стота F, Гц». Разместить их как показано на рис. 2.6.

8. Из подменю Numeric палитры Controls (Modern→Numeric) вы-
брать Numeric Control – 2 шт. Ввести в метки их названия «Длитель-
ность импульса», «Тип сигнала». Разместить их, как показано на рис. 2.6.

4. Занести в поле La-
bel величины: Y1, Y2, Y3, 
Y4, Y5, Y6, E, N, которые 
являются необходимыми 
данными для расчета фор-
мулы. В больших верхних 
полях ввести формулы для 
вычисления N, U2, U4. Вве-
сти в метки их названия: 
«N», «U2», «U4».

5. С помощью монтаж-
ного инструмента «Катуш-
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9. Из палитры Controls выбрать 3 графических индикатора Wave-
form Graph для отображения сигнала и перенести их на лицевую па-
нель (Modern→Graph→Waveform Graph). Ввести в метки их названия 
«U2», «U4», «U2-U4». Разместить их, как показано на рис. 2.6.

Рис. 2.6. Структурная схема установки

10. Перейти в режим Block Diagram.
11. Создать генератор. Из палитры Functions→Signal Processing→Sig 

Generator→SigGen Duration.
12. Из палитры Tools выбрать монтажный инструмент «Катушку».
13. Соединить:

– регулятор «Тип сигнала» с входом генератора signal type;
– вход «frequency» генератора с «Частотой»;
– вход «duration» генератора с «Длительностью импульса»;
– вход «amplitude» генератора с «Амплитудой»;
– выход «signal» генератора с входами «Е» блоков-формул  U2, U4;
– выход «result» блоков – формул U2, U4 с входами графических 

индикаторов  «U2», «U4».
14. Вычесть из «U2» величину «U4», используя разность (Functions

→Mathematics→Numeric→Subtract).
15. Соединить выход разности с графическим индикатором «U2-U4».
16. Задать все значения.
17. Запустить работу ВП. 
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18. Примеры итоговой панели при различных состояниях РДС при-
ведены на рис. 2.7 и 2.8.

Рис. 2.7. Итоговая Front Panel. В РДС обеспечена развязка

Рис. 2.8. Итоговая Front Panel. В РДС развязка не обеспечена

Задание

1. Создать структурную схему.
2. Задавая произвольные значения периода, амплитуды, фазы сиг-

нала, добиться полной развязки РДС, изменяя для этого значения со-
противлений. Найти пять вариантов значений сопротивлений, при ко-
торых будет обеспечиваться развязка устройства.
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3. Исследовать поведение РДС при полной развязке при изменении:
– периода;
– амплитуды;
– фазы сигнала.
4. Исследовать уровень проникновения нежелательного сигнала 

(ухудшение развязки) при неточной балансировке моста.
5. Зарисовать полученные осциллограммы.

Содержание отчета
1. Краткая теория.
2. Структурная схема.
3. Осциллограммы.
4. Выводы.

 Контрольные вопросы
1. Выполнением каких требований обусловливается взаимность РУ?
2. Сравните РДС и ТДС и найдите их основные различия.
3. Дайте определение пассивным РУ.
4. При каких условиях схема будет являться сбалансированной и 

уравновешенной?
5. Какой параметр линии передачи нужно учитывать при выборе РДС?
6. Зависят ли параметры активных параметрических РУ от уровня 

сигнала? 
7. Зависят ли параметры параметрических РУ от уровня сигнала? 
8. Какие виртуальные приборы были использованы Вами для из-

мерения параметров РУ?
9. Варианты построения РДС.

10. Как определяются напряжения в узлах исследуемой схемы?
11. Как по осциллограммам  U2, U4 определить, развязана ли РДС?
12. Зачем нужна развязка в линиях передачи?
13. Перечислить негативные последствия плохой развязки.

Лабораторная работа № 3

ИССЛЕДОВАНИЕ ТРАНСФОРМАТОРНОЙ 
ДИФФЕРЕНЦИАЛЬНОЙ СИСТЕМЫ

Цель работы
Создание виртуального прибора ТДС в виде наглядной графиче-

ской блок-схемы, приобретение навыков измерения основных пара-
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метров исследуемого виртуального прибора (обеспечение развязки, 
равновесия моста), обработка результатов измерений, анализ данных, 
представление результатов измерений в виде таблиц и графиков.

Краткие теоретические сведения
Принципиальная схема нагруженной трансформаторной диффе-

ренциальной системы (ТДС) приведена на рис. 3.1, где приняты следу-
ющие обозначения: ДТ – дифференциальный трансформатор; 1-1, 2-2, 
3-3, 4-4 – полюса подключения нагрузочных сопротивлений.

К полюсам 1-1 подключается двухпроводная линия с входным сопро-
тивлением Z1; к полюсам 2-2 – двухпроводная линия с входным сопротив-
лением Z2; к полюсам 4-4 – двухпроводная линия с входным сопротивле-

Рис. 3.1. Трансформаторная диффе-
ренциальная система

n = n1 + n2 =
 W11 +

 W12 =
 W1,W2     W2      W2

где n – коэффициент трансформации ДТ; n1 и n2 – коэффициенты транс-
формации между вторичной обмоткой и полуобмотками первичной об-
мотки ДТ.

η =
 W11 – коэффициент неравноплечности ТДС.      W12

Если η = 1, то схема равноплечая.

нием Z4; к зажимам 3-3 подключается 
так называемое балансное сопротив-
ление Z3.

Z11 – входное сопротивление ТДС 
со стороны полюсов 1-1; Z22 – вход-
ное сопротивление ТДС со стороны 
полюсов 2-2; Z44 – входное сопротив-
ление ТДС со стороны полюсов 4-4; 
Z33 – входное сопротивление ТДС со 
стороны полюсов 3-3; W11 – коли-
чество витков первой полуобмотки 
первичной обмотки ДТ; W12 – коли-
чество витков второй полуобмотки 
первичной обмотки ДТ; W2 – количе-
ство витков вторичной обмотки ДТ.

Обозначим коэффициенты транс-
формации ДТ следующим образом:
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Если η ≠ 1, то схема неравноплечая.
При анализе будем считать ТД идеальным. Этому соответствуют 

следующие свойства: отсутствуют потери, индуктивности обмоток 
бесконечно велики, а рассеяние энергии в них отсутствует.

Определение условия отсутствия пропускания ТДС от полюсов 4-4 
к полюсам 2-2 (рис. 3.2).

Рис. 3.2.  Эквивалентная схема 
уравновешенной ТДС при 
передаче от полюсов 4-4 к 

полюсам 2-2

Условие непропускания или бесконечно большого затухания в 
направлении 4-2:

W11 =
 I3 = η =

 Z1;
 
Z3 =

 Z1.W12    I1           Z3          η
Определение входных сопротивлений ТДС
Со стороны полюсов 4-4
При выполнении этого условия энергия от полюсов 4-4 к полюсам 

При подключении генератора сигналов 
в точках 4 токи текут в противоположных 
направлениях. Эти токи в трансформаторе 
порождают два  магнитных потока: I1W11; 
I3W12. Потоки направлены противополож-
но друг другу, при этом суммарный поток 
равен их разности. Если I1'W1'1 = I3''W1''2, то 
при этом условии они взаимно уничтожа-
ются, и на второй обмотке никакой ЭДС не 
наводится. Таким образом осуществляется 
развязка между клеммами 44 и 22.

Рис. 3.3. Определение входного 
сопротивления со стороны 
полюсов 2-2

2-2 не передается и из эквивалентной 
схемы (рис. 3.2) следует, что входное 
сопротивление со стороны полюсов 4-4 
равно

.

Для согласованного включения на-
грузок должно выполняться условие

1Z4 = Z44 = Z1 1 + η
.

1
1

1
1

1

1
1

31

31
44 Z

ZZ

ZZ

ZZ
ZZ

Z
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Со стороны полюсов 2-2 (рис. 3.3).

Сопротивления Z1 и Z3 со стороны полюсов 2-2 включены последо-
вательно. Входное сопротивление ДС со стороны полюсов 2-2

Z22 =
 Z1 + Z2 = Z1 + Z2/η = Z1

 1 + η.
      

η2            n2                n2η
Из условия согласованного подключения нагрузок следует, что

Z2 = Z22 = Z1
 1 + η,n2η

Рис. 3.4. Определение затуханий. 
Направления 2-2→1-1, 2-2→3-3

(рис. 3.4).
W2 – мощность, отдаваемая гене-

ратором в нагрузки Z1 и Z2, на кото-
рых выделяются мощности W1 и W3 
соответственно, I – ток, протекаю-
щий через нагрузки Z1, Z3.

W1 = I2Z1,

W3 = I2Z3 = I2 Z1.η
 1W2 = W1 + W3 = I2Z1(1 +  η)

1
Z
Z

2

1n .

Со стороны полюсов 3-3

Если со стороны полюсов 1-1, 2-2 и 4-4 нагрузки подключены со-
гласованно, то входное сопротивление со стороны полюсов 3-3 равно

Z33 = Z3 = Z1/η.
Со стороны полюсов 1-1

Если нагрузки на полюсах 2-2, 3-3 и 4-4 равны Z2, Z3 и Z4, то вход-
ное сопротивление со стороны полюсов 1-1:

Z11=Z1.
Если все выходы схемы согласованы, то между клеммами 11 и 33 

наблюдается развязка. При этом условие сбалансированности:
n2

Z4 = ηZ2 (1 + η)2.

Определение затуханий уравновешенной ТДС в различных направ-
лениях передачи.

При направлении от полюсов 2-2 к полюсам 1-1, 3-3 и обратно 
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Затухание (ослабление) сигнала при передаче от полюсов 2-2 (1-1) 

к полюсам 1-1 (2-2) A22→11 = A11→22 = 10lg W2 = 10lg (1 + η).W1                 η
Затухание (ослабление) сигнала при передаче от полюсов 2-2 (3-3) 

к полюсам 3-3 (2-2) A22→33 = A33→22 = 10lg(1 + η).
Если схема равноплечая, то во всех направлениях затухания равны 3дБ.

Рис. 3.5. Определение затуханий. На-
правления 4-4→2-2, 4-4→3-3

следовательно, мощность на полюсах 4-4 W4 = I2
1Z(1 + η).

Затухание сигнала равно

A44→11 = A11→44 = 10lgW4 = 10lg(1 + η);W1 

A44→33 = A33→44 = 10lgW4 = 10lg(1 + 1).W3                     η

При направлении от полюсов 4-4 
к полюсам 2-2, 3-3 и обратно. (рис. 3.5)

Мощность генератора, подве-
денная к полюсам 4-4, распределяет-
ся между сопротивлениями Z1 и Z3

W4 = W1 + W3 = J1
2Z1 + J2

3Z3
где W1, W3 – мощности на сопро-
тивлениях Z1, Z3.

Z3 =
 Z1; I3 = ηI1,η

14= 41= 23= 32 

12= 21= 34= 43 

,  

3 

 
0 1,0 

Рис. 3.6. Зависимость от значения η затухания 
ТДС в направлениях пропускания

- возможность согласованного подключения до четырех различных 
по величине сопротивлений нагрузок;

Полученные зави-
симости в графической 
форме приведены на 
рис. 3.6.

Сравнение ТДС и 
РДС.

Достоинства ТДС: 
- отсутствуют галь-

ванические (по постоян-
ному току) связи между  
полюсами подключения 
нагрузок;
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- сравнительно небольшие затухания в направлениях пропускания.
Недостатки ТДС: 
- нелинейные искажения, вносимые трансформаторами с ферро-

магнитными сердечниками, величина которых тем больше, чем мень-
ше сечение сердечника и чем больше передаваемая мощность сигнала;

- для получения равномерной частотной характеристики затухания 
ТДС в направлениях пропускания необходимо увеличение индуктив-
ности обмоток ДТ, что достигается применением сердечников из вы-
сококачественных ферромагнитных материалов или увеличением сече-
ния сердечника;

- сравнительно большие размеры, масса и относительно высокая 
стоимость.

Достоинства РДС: 
- простота изготовления, малый вес, небольшие габариты, низкая 

стоимость, возможность ее миниатюризации;
- равномерная частотная характеристика затухания во всех направ-

лениях пропускания;
- отсутствие нелинейных искажений;
- возможность согласованного включения четырех и даже шести 

одинаковых сопротивлений;
- наличие трех направлений непропускания при соответствующей 

конфигурации мостовой схемы.
Недостатки РДС :
- сравнительно большое затухание в направлениях пропускания;
- наличие гальванических связей между всеми сопротивлениями 

нагрузок;
- если хотя бы одно из сопротивлений нагрузок комплексное, то и 

все остальные пять сопротивлений также должны быть комплексными.

Создание лабораторной установки

Рис. 3.7. Схема лабораторной установки

Используя программную сре-
ду LabView, создать схему уста-
новки, изображенную на рис. 3.7.

Сумма токов, втекающих в 
узел, равна сумме токов, вытека-
ющих из него, поэтому из метода 
узловых напряжений следует:

Узел 1-й: Y6E=(Y1+Y2+Y3)U1– 
– Y2U2–Y1U4.
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Узел 2-й: 0=(Y2+Y5+Y3)U2–Y2U1–Y5U4.
Узел 4-й: 0=(Y1+Y2+Y4)U4–Y1U1–Y5U2,

1           1           1           1           1           1 где Y1 = Z1
, Y2 = Z2

, Y3 = Z3
, Y4 = Z4

, Y5 = Z5
, Y6 = Z6

.

Отсюда напряжения в узлах 2 и 4 равны

U4 = E Y6[Y1(Y2 + Y3) + (Y1 + Y2)Y5];N

U2 = E Y6[Y2(Y1 + Y4) + (Y1 + Y2)Y5],N
где  
N = Y5[(Y1 + Y2) (Y3 + Y4) + Y6(Y1 + Y2 + Y3 + Y4)] + Y1Y4(Y2 + Y3) +

+ Y2Y3(Y1 + Y4) + Y6(Y1 + Y4) (Y2 + Y3).
Последовательность операций:

1. В режиме Front Panel из подменю Numeric палитры Controls 
(Modern→Numeric) выбрать Numeric Control – 6 раз.  Ввести в метки 
их названия: «Х1», «Х2», «Х3», «Х4», «Х5», «Х6». Сделать их «Complex 
Double» (правая кнопка мышки→Representation→ Complex Double).

2. Для создания блока расчета узлов U2 и U4 и задания коэффици-
ента N используются функции (Functions → Mathematics → Numeric → 
Add, Reciprocal, Multiply, Divide) в режиме Block Diagram:

- 6 математических функций Reciprocal (1/х);
- 11 сумматоров Add;
- 12 умножителей Multiply;
- 2 делителя Divide.
3. Из палитры Tools выбрать монтажный инструмент «Катушка».
4. Соединить схему по формулам, как показано на рис. 3.8.

Рис. 3.8. Фрагмент исследуемой схемы
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5. Разложить получившиеся комплексные значения U2 и U4 на дей-
ствительную и мнимую части (Functions→Mathematics→Numeric→
Complex→Complex to Re/Im).

6. Далее необходимо вернуться на лицевую панель. Чтобы сде-
лать это, надо выбрать в меню Window => Snow Front Panel.

7. Из подменю Numeric палитры Controls (Modern→Numeric) 
выбрать Dial – 2 шт. Ввести в метки их названия: «Амплитуда Е, В», 
«Частота F, Гц». Разместить их, как показано на рис. 3.9.

8. Из подменю Numeric палитры Controls (Modern→Numeric) 
выбрать Numeric Control – 2 шт. Ввести в метки их названия «Дли-
тельность импульса», «Тип сигнала». Разместить их, как показано 
на рис. 3.9.

9. Из подменю Numeric палитры Controls (Modern→Numeric) 
выбрать Numeric Indicator – 4 шт. Ввести в метки их названия 
«Фаза2», «Фаза4», «U2max», «U4max». Разместить их, как показано 
на рис. 3.9.

10. Из палитры Controls выбрать кнопку Push Button 
(Modern→Boolean→ Push Button). Разместить их, как показано на 
рис. 3.9.

11. Из палитры Controls выбрать 3 графических индикатора Wave-
form Graph для отображения сигнала и перенести их на лицевую па-
нель (Modern→Graph→Waveform Graph). Ввести в метки их названия 
«U2», «U4», «U2-U4». Разместить их, как показано на рис. 3.9.

12. Перейти в режим Block Diagram.
13. Создать 2 генератора из палитры Functions→Signal 

Processing→Sig Generator→SigGen Duration.
14. Выбрать Functions→Programming→Waveform→Analog Wave-

form→ Waveform Measurements→Ampl & Level – 2 шт.
15. Перемножить действительные части с амплитудой входного 

сигнала и подать на вход «amplitude» генераторов.
16. Сложить мнимые части с выходами генераторов «phase out».
17. Вычесть из «U2»  «U4», используя разность (Functions→Math

ematics→Numeric→Subtract).
18. Из палитры Tools выбрать монтажный инструмент «Катушку».
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19. Соединить:
- мнимые части с входом генератора «phase in»;
- регулятор «Тип сигнала» с входом генератора «signal type»;
- входы «frequency» генераторов с выбранной частотой;
- входы «duration» генераторов с выбранной длительностью 

импульса;
- выходы сумматоров с точками «Фаза 2», «Фаза 4»;
- входы «signal» генераторов с точками «U2», «U4»;
- входы «Ampl & Level» с выходами генераторов «signal»;
- выходы «high state level», «Ampl & Level» с «U2max», «U4max»;
- выход разности с графическим индикатором «U2-U4».
20. Задать все требуемые значения параметров.
21. Запустить работу виртуального прибора.
22. Добиться разной степени развязки (рис. 3.10, 3.11).

Рис. 3.10. Итоговая Front Panel. ТДС развязана

Рис. 3.11. Итоговая Front Panel. ТДС неразвязана

Задание

1. Создать структурную схему.
2. Задавая различные значения параметров сигнала, добиться пол-

ной развязки ТДС, изменяя значения сопротивлений.
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3. Исследовать поведение ТДС при изменении соотношений дей-
ствительной и мнимой частей сопротивлений.

4. Исследовать ТДС при различных входных сигналах.
5. Исследовать зависимость разности от разбалансировки моста.
6. Зарисовать полученные осциллограммы.

Содержание отчета

1. Краткая теория.
2. Структурная схема.
3. Осциллограммы.
4. Выводы

 Контрольные вопросы

1. Назовите виды РУ.
2. Нарисуйте обобщенную схему ТДС и объясните принцип ее работы.
3. В чем отличие РДС от ТДС?
4. Назовите основные недостатки и достоинства ТДС.
5. Нарисуйте эквивалентную схему неуравновешенной ТДС.
6. Назовите условие сбалансированности моста.
7. Чему равен коэффициент затухания во всех направлениях при рав-

новесных плечах?
8. Как по осциллограммам  U2, U4 определить, развязана ли ТДС?
9. Как определяются напряжения в узлах исследуемой схемы?

10. Свойства идеального ДТ.
11. Зависимость затухания ТДС в направлениях пропускания от зна-

чения η.
12. Как определяются входные сопротивления ТДС?

Лабораторная работа № 4

ИЗУЧЕНИЕ ВЛИЯНИЯ АМПЛИТУДНО-ЧАСТОТНЫХ 
И ФАЗОЧАСТОТНЫХ ХАРАКТЕРИСТИК КАНАЛА СВЯЗИ 

НА ПЕРЕДАВАЕМЫЙ СИГНАЛ

Цель работы

Изучение амплитудно-частотных и фазочастотных искажений сиг-
нала. Исследование с помощью виртуальной лабораторной установки 
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зависимости искажений от различных параметров фильтров, имитиру-
ющих канал передачи.

Краткие теоретические сведения

Искажения сигнала проявляются в несоответствии принятого сиг-
нала передаваемому.

Виды искажений:
Нелинейные искажения
Искажения, проявляющиеся в появлении в частотном спектре вы-

ходного сигнала составляющих, отсутствующих во входном сигнале. 
Нелинейные искажения представляют собой изменения формы колеба-
ний, проходящих через электрическую цепь (например через усилитель 
или трансформатор), вызванные нарушениями пропорциональности 
между мгновенными значениями напряжения на входе этой цепи и на 
ее выходе. Это происходит, когда зависимость выходного напряжения 
от входного – нелинейная функция. 

Количественно нелинейные искажения оцениваются коэффици-
ентом нелинейных искажений (КНИ), или коэффициентом гармоник. 
Типовые значения КНИ : 0 % — синусоида; 3 % — форма, близкая к си-
нусоидальной; 5 % — форма, приближенная к синусоидальной (откло-
нения формы уже заметны на глаз); до 21 % — сигнал трапецеидальной 
или ступенчатой формы; 43 % — сигнал прямоугольной формы.

Амплитудно-частотные искажения
Искажения, проявляющиеся в изменении соотношения амплитуд 

спектральных составляющих сигнала после прохождения через цепь 
с неравномерной амплитудно-частотной характеристикой (АЧХ). По-
казателем степени частотных искажений, возникающих в каком-либо 
устройстве, служит неравномерность его АЧХ, ее количественным по-
казателем на какой-либо конкретной частоте спектра сигнала является 
коэффициент частотных искажений.

Коэффициент частотных искажений — отношение коэффициен-
та передачи на средних частотах спектра сигнала к его значению на 
данной частоте.

Фазочастотные искажения
Искажения, вызванные нарушением фазовых соотношений между 
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отдельными спектральными составляющими сигнала при прохождении 
по каналу передачи. Они возникают из-за нелинейности фазочастотной 
характеристики канала, так как время задержки различных составля-
ющих спектра сигнала различается на разных частотах. Показателем 
степени фазочастотных искажений считается неравномерность груп-
пового времени запаздывания (ГВЗ) в полосе рабочих частот сигнала. 
Временнóе запаздывание на различных частотах равно производной от 
фазочастотной характеристики по частоте.

Динамические искажения
Это искажения формы сигнала, возникающие в усилителях (глав-

ным образом операционных), из-за ограниченной скорости нарастания 
выходного напряжения при быстрых изменениях входного напряжения.

Взаимомодуляционные искажения характеризуются коэффициен-
том взаимных модуляционных искажений.

Коэффициент взаимных модуляционных искажений — отношение 
мощности комбинационной составляющей спектра выходного сигнала 
радиопередатчика к мощности несущей сигнала. 

Краевые искажения
Искажения, вызванные смещением краёв элементов двоичного сиг-

нала относительно их заданного положения.
В процессе выполнения работы имитируется воздействие 

амплитудно-частотных и фазочастотных искажений на сигнал при про-
хождении канала передачи и оценивается их величина. Канал передачи 
имитируется фильтрами с различными частотными характеристиками.

Создание виртуальной установки

Для создания лабораторной установки необходимо сначала создать 
анализатор спектра сигналов (пункты 1-17), затем подключить фильтр. 
Для этого:

1. Из подменю Graph палитры Controls (Modern→Graph)  выбрать 
графический индикатор (Waveform Graph) для отображения сигнала и 
перенести его на лицевую панель. Разместить его справа наверху лице-
вой панели. В появившейся метке можно тут же с клавиатуры ввести 
название индикатора «Сигнал до фильтрации».

2. Второй графический индикатор для наблюдения амплитудного 
спектра выбрать анало гично п. 1. Поместить индикатор на лицевой па-
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нели ниже первого инди катора. Ввести в метку его название «Ампли-
тудный спектр до фильтрации».

3. Третий графический индикатор для наблюдения фазового спек-
тра выбрать анало гично п. 1. Поместить индикатор на лицевой пане-
ли ниже второго инди катора. Ввести в метку его название «Фазовый 
спектр до фильтрации».

4. Из подменю Numeric палитры Controls (Modern→Numeric) вы-
брать три вертикальных ползунковых регулятора (Vertical Pointer Slide) 
для регуляторов «Амплитуда», «Длительность» и «Задержка», разме-
стить их на лицевой панели слева от индикаторов сверху вниз и ввести 
их названия в метки.

5. Разместив индикаторы и органы управления на лицевой панели, 
можно пе рейти к блок-схеме. Чтобы сделать это, надо выбрать в меню 
Window => Snow Block Diagram.

6. Из подменю Numeric палитры Functions (Programming→Numeric) 
выбрать числовую константу (Numeric Constant) и поместить ее на 
блок-схеме выше терминалов органов управления. С помощью Меточ-
ного инструмента ввести в константу зна чение 800. Этой константой 
задается количество точек (отсчетов) для ото бражения прямоугольного 
импульса.

7. Из палитры Functions выбрать подменю Signal Processing, а из 
него - Signal Generation. Из этого подменю выбрать гене ратор пря-
моугольного импульса (Pulse Pattern.vi) и поместить его на блок-схеме 
справа от терминалов органов управления.

8. Из подменю Signal Processing выбрать подменю Spectral Analy-
sis. Из него выбрать вычислитель спектра Amlitude and Phase Spectrum.
vi и помести ть его на блок-схеме между генератором прямоугольного 
импульса и тер миналами индикаторов.

9. Из палитры Tools выбрать Монтажный инструмент («Катушку»).
10. Подключить числовую константу к терминалу «samples» генера-

тора прямоугольного импульса.
11. Подключить терминал регулятора «Амплитуда» к терминалу ге-

нератора Amplitude.
12. Подключить терминал регулятора «Задержка» к терминалу гене-

ратора delay.
13. Подключить терминал регулятора «Длительность» к терминалу 

генератора «width».
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14. Подключить выходной терминал генератора прямоугольного 
импульса «Pulse Pattern» к входному терминалу вычислителя спектра.

15. Подключить выходной терминал вычислителя спектра «Amp 
Spectrum mag» к терминалу индикатора «Амплитудный спектр до филь-
трации».

16. Подключить выходной терминал вычислителя спектра «Amp 
Spectrum Phase» к терминалу индикатора «Фазовый спектр до филь-
трации».

17. Подключить терминал индикатора «Сигнал до фильтрации» к 
проводу, соединяющему выходной терминал генератора и входной тер-
минал вычислителя спектра.

18. После создания анализатора спектра необходимо вернуться на 
лицевую панель. Чтобы сделать это, надо выбрать в меню Window => 
Snow Front Panel. 

19. Необходимо создать ещё три графических индикатора с назва-
ниями «Сигнал после фильтрации», «Амплитудный спектр после филь-
трации», «Фазовый спектр после фильтрации» как это описано в п. 1-3. 
Разместить их справа на лицевой панели.

20. Графический индикатор для наблюдения амплитудно-частотной 
характеристики фильтра выбрать аналогично п. 1. Поместить индика-
тор в правом нижнем углу лицевой панели. Ввести в метку его назва-
ние «АЧХ фильтра».

21. Аналогично п. 4 выбрать три регулятора «Частота дискретиза-
ции», «Нижняя граничная частота», «Верхняя граничная частота». Раз-
местить их над индикатором «АЧХ фильтра».

22. Из подменю Numeric палитры Controls выберите Numeric Con-
trol. Ввести в метку его название «Тип фильтра».

23. Аналогично п. 5 перейти к блок-схеме лабораторной установки.
24. Аналогично п. 7 выбрать генератор шума – Bernoulli Noise.vi.
25. Из подменю Signal Processing выбрать подменю Filters. Из него 

выбрать фильтр Баттерворта (Butterworth fi lter (DBL).vi).
26. Необходимо поставить ещё один фильтр Баттерворта. Для этого 

повторить п. 25 ещё раз.
27. Необходимо поставить ещё два вычислителя спектра. Для этого 

повторить п. 8 два раза.
28. Аналогично п. 9 выбрать монтажный инструмент.
29. Подключить терминал «Тип фильтра» к терминалу фильтра Fil-

ter Type.
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30. Подключить терминал «Частота дискретизации» к терминалу 
фильтра Sample freq.

31. Подключить терминал «Нижняя частота среза» к терминалу 
фильтра Low cutoff freq.

32. Подключить терминал «Верхняя частота среза» к терминалу 
фильтра High cutoff freq.

33. Повторить п. 28 – 32 для второго фильтра.
34. Подключить терминал фильтра  X к проводу, соединяющему 

выходной терминал генератора прямоугольного импульса и входной 
терминал вычислителя спектра.

35. Подключить выходной терминал фильтра  «fi ltered X» к терми-
налу вычислителя спектра № 1, созданному в п. 27.

36. Подключить терминал индикатора «Сигнал после фильтрации» 
к проводу, соединяющему выходной терминал фильтра и входной тер-
минал вычислителя спектра.

37. Подключить выходной терминал вычислителя спектра «Ampli-
tude Spectrum» к терминалу индикатора «Амплитудный спектр после 
фильтрации».

38. Подключить выходной терминал вычислителя спектра «Phase 
Spectrum» к терминалу индикатора «Фазовый спектр после фильтрации».

39. Подключить выходной терминал генератора шума к терминалу 
X фильтра № 2, созданного в п. 26.

40. Аналогично п. 35 соединить фильтр № 2 с вычислителем спек-
тра №2, созданным в п. 27.

41. Подключить терминал индикатора «АЧХ фильтра» к выходному 
терминалу вычислителя спектра № 2 «Amplitude Spectrum».

Примечания.
«Тип фильтра» 0 – ФНЧ, 1 – ФВЧ, 2 – полосовой, 3 – режекторный. 
Нижняя частота среза не должна превышать половины частоты 

дискретизации.
Верхняя частота среза (когда она используется) должна быть не 

меньше нижней частоты среза. 
При несоблюдении этих условий фильтр не будет выдавать выход-

ной сигнал.

Задание
1. Создать структурную схему установки в среде LabView (рис. 4.1).
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2. Для прямоугольного импульса и шумового сигнала сравнить вид 
сигналов и их спектры до и после прохождения через фильтр. Зарисо-
вать все полученные осциллограммы (рис. 4.2).

Рис. 4.1. Структурная схема установки

Рис. 4.2. Итоговая Front Panel. Прохождение сигнала через канал передачи 
(имитируется фильтрами различного вида)

3. Оценить амплитудно-частотные искажения, возникающие при 
прохождении сигнала через фильтр, имитирующий канал передачи. Для 
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этого сравнить амплитудные спектры сигналов до и после фильтрации. 
В полосе частот, задаваемой преподавателем, оценить амплитудно-
частотные искажения при различных параметрах фильтра и сигнала. 

4. Оценить возникающие фазочастотные искажения. Для этого 
сравнить фазовые спектры сигналов до и после фильтрации и постро-
ить фазочастотную характеристику фильтра, имитирующего канал 
передачи. На ее основе построить зависимость времени запаздывания 
спектральных составляющих сигнала на различных частотах. В полосе 
частот, задаваемой преподавателем, оценить неравномерность ГВЗ при 
различных параметрах фильтра и сигнала.

Проанализировать результаты. 

Дополнительное задание (выполняется по указанию преподавателя)
1. Вместо фильтра поместить звено с нелинейной амплитудной ха-

рактеристикой (односторонний или двусторонний ограничитель, ква-
дратор, звено со степенной характеристикой разных степеней).

2. Выбрать генератор синусоидального сигнала.
3. Зарисовать сигналы до и после нелинейного звена.
4. Сравнить амплитудные спектры сигнала до и после нелинейного 

звена. Зарисовать спектрограммы.
5. В качестве источника сигнала создать сумматор синусоидальных 

сигналов от двух различных генераторов близких частот. 
6. Повторить пп. 3 и 4.
7. Вместо генератора синусоидального сигнала использовать гене-

ратор шумового сигнала. Повторить пп. 3 – 5.
8. Проанализировать результаты.

Содержание отчета
1. Краткая теория.
2. Структурная схема.
3. Осциллограммы и спектрограммы.
4. Выводы.

Контрольные вопросы
1. Что такое искажения сигнала?
2. Из-за чего возникают фазочастотные искажения?
3. В чём проявляются амплитудно-частотные искажения?
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4. В чём проявляются фазочастотные искажения?
5. Как и в чем измеряются амплитудно-частотные искажения?
6. Как и в чем измеряются фазочастотные искажения?
7. Какие еще виды искажений могут возникать при передаче сигналов?
8. Какие терминалы используются у генератора прямоугольных им-

пульсов и на что они влияют? 
9. Какие типы фильтров можно реализовать на базе фильтра Бат-

терворта?
10. На что влияет изменение нижней частоты среза?
11. В каких режимах работы фильтра используется верхняя часто-

та среза?
12. Какие ограничения накладываются на верхнюю и нижнюю ча-

стоты среза?
13. Что такое коэффициент частотных, перекрестных и взаимномо-

дуляционных искажений?
14. Как изменяются амплитудно-частотные искажения при измене-

нии параметров фильтра?
15. Как изменяются фазочастотные искажения при изменении пара-

метров фильтра? 

Лабораторная работа № 5

ИЗУЧЕНИЕ ПРИНЦИПОВ ЧАСТОТНОГО РАЗДЕЛЕНИЯ 
СИГНАЛОВ

Цель работы
Изучение принципов построения многоканальных систем переда-

чи (СП) с частотным разделением каналов.
 
Краткие теоретические сведения
Функциональная схема простейшей системы многоканальной свя-

зи с разделением каналов по частоте представлена на рис. 5.1. 
В зарубежных источниках для обозначения принципа частотно-

го разделения каналов (ЧРК) используется термин Frequency Division 
Multiply Access (FDMA). 

При осуществлении ЧРК первичные (индивидуальные) сигналы, 
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имеющие энергетические спектры G1(w), G2(w), ..., GN(w) в соответствии 
с передаваемыми сообщениями модулируют поднесущие частоты wK 
каждого канала. Эту операцию выполняют модуляторы М1, М2, ..., МN ка-
нальных передатчиков. Полученные на выходе частотных фильтров Ф1, 
Ф2, ... , ФN спектры gK(w) канальных сигналов занимают соответствен-
но полосы частот Dw1, Dw2, ..., DwN, которые в общем случае могут от-
личаться по ширине от спектров сообщений W1, W2, ..., WN. Рассмотрим 
случай, когда используется однополосная амплитудная модуляция (АМ-
ОБП, как это принято в аналоговых системах передач с ЧРК).

Рис. 5.1. Функциональная схема системы многоканальной связи 
с частотным разделением каналов

Если полагать, что спектры индивидуальных сигналов конечны, то 
можно выбрать поднесущие частоты wK таким образом, чтобы полосы 
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Dw1, ...,  DwK попарно не перекрывались. При этом условии получив-
шиеся сигналы sК(t) (k=1,...,N) в каждой полосе взаимно ортогональны.

Затем спектры g1(w), g2(w),..., gN(w) суммируются (образуется сиг-
нал S) и их совокупность g(w) поступает на групповой модулятор (М). 
Здесь спектр g(w) с помощью колебания несущей частоты w0 перено-
сится в область частот, отведенную для передачи данной группы ка-
налов, т.е. групповой сигнал s(t) преобразуется в линейный sЛ(t). При 
этом может использоваться любой вид модуляции.

На приемном конце линейный сигнал поступает на групповой де-
модулятор (приемник П), который преобразует спектр линейного сиг-
нала в спектр группового сигнала gс (w). Спектр группового сигнала 
затем с помощью частотных фильтров (Ф1, Ф2,...,ФN) вновь разделяется 
на отдельные полосы DwK, соответствующие отдельным каналам. По-
сле этого канальные демодуляторы (Д) преобразуют спектры сигналов 
gK(w) в спектры сообщений Gс K(w), предназначенные получателям.

Проследим основные этапы образования сигналов, а также измене-
ние этих сигналов в процессе передачи (рис. 5.2). 

На приемной стороне одновременно действуют сигналы всех ка-
налов, различающиеся положением их частотных спектров на шкале 
частот. Чтобы без взаимных помех разделить такие сигналы, приемные 
устройства должны содержать частотные фильтры. Каждый из филь-
тров ФK должен пропустить без ослабления лишь те частоты, которые 
принадлежат сигналу данного канала; частоты сигналов всех других 
каналов фильтр должен подавить.

На практике это невыполнимо. Результатом являются взаимные по-
мехи между каналами. Они возникают как за счет неполного сосредо-
точения энергии сигнала k-го канала в пределах заданной полосы ча-
стот DwK, так и за счет неидеальности реальных полосовых фильтров. 
В реальных условиях приходится учитывать также взаимные помехи 
нелинейного происхождения, например за счет нелинейности характе-
ристик группового канала.

Для снижения переходных помех до допустимого уровня прихо-
дится вводить защитные частотные интервалы  ∆ωзащ (рис. 5.3). 

Так, например, в современных системах многоканальной телефон-
ной связи каждому телефонному каналу выделяется полоса частот 4 
кГц, хотя частотный спектр передаваемых звуковых сигналов ограни-
чивается полосой от 300 до 3400 Гц, т.е. ширина спектра составляет 
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3,1 кГц. Между полосами частот соседних каналов предусмотрены 
интервалы шириной по 0,9 кГц, предназначенные для снижения уров-

Рис. 5.2. Преобразование спектров в системе с частотным разделением каналов

ня взаимных помех при расфильтровке сигналов. Это означает, что в 
многоканальных системах связи с частотным разделением сигналов 
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эффективно используется лишь около 80 % полосы пропускания линии 
связи. Кроме того, необходимо обеспечить высокую степень линейно-
сти всего тракта группового сигнала.

Рис. 5.3. Спектр группового сигнала с защитными интервалами

На практике используются пять типов канальных сигналов с АМ:
1. Две боковые полосы частот и несущая частота.
2. Одна боковая полоса частот и несущая частота.
3. Одна боковая полоса частот без несущей частоты (АМ ОБП). 
4. Две боковые полосы частот без несущей частоты.
5. Несимметричные боковые полосы частот.
Анализ искажений в системах с ЧРК связан с большими математи-

ческими трудностями, поэтому обычно вводят следующие допущения 
и идеализацию:

1. Основная доля искажений обусловлена неидеальностью харак-
теристик группового тракта. Искажения, возникающие в отдельных ка-
нальных трактах, значительно меньше и их можно не учитывать.

2. Искажения в групповом тракте можно разделить на две незави-
симые составляющие: искажения в высокочастотной части тракта (ис-
кажения модулированного сигнала) и искажения в видеотракте (иска-
жения многоканального сообщения).

3. Основной причиной искажений сигнала в высокочастотной части 
тракта можно назвать неравномерность частотной и нелинейность фазо-
вой характеристик усилителя промежуточной частоты приемника в пре-
делах полосы частот, занимаемой спектром модулированного сигнала.

4. Основной причиной искажений в видеотракте является нели-
нейность его модуляционной и демодуляционной характеристик, ко-
торые при анализе можно рассматривать как единую модуляционно-
демодуляционную характеристику.

Для сравнения типов канальных сигналов используют три кри-
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терия: ширину спектра, мощность, сложность устройств. Канальный 
сигнал АМ ОБП имеет самую узкую ширину спектра и самую мини-
мальную мощность, однако для его формирования требуются сложные 
устройства. Именно этот тип канального сигнала считается основным 
в системе передачи с ЧРК (аналоговых СП).

Групповой сигнал получают объединением канальных сигналов. 
Передача группового сигнала обеспечивается по линейному тракту, ко-
торый в аналоговых СП состоит из участков кабельных или воздушных 
линий связи и усилителей.

Создание виртуальной установки

СП рассчитана на организацию трех каналов ТЧ с использованием 
типов канальных сигналов АМ. В качестве переносчиков применяются 
гармонические колебания с частотами 7, 8, 9 кГц.

1. В режиме Front Panel из палитры Controls выбрать  графиче-
ский индикатор Waveform Graph для отображения сигнала и перенести 

Рис. 5.4. Структурная схема установки

Повторить действие, что бы было выбрано всего 6 генераторов. Разме-
стить их, как показано на рис. 5.4.

4. Из палитры Functions выбрать фильтр Filter (Express→Signal 

его на лицевую панель 
(Modern→Graph→ Wave-
form Graph). Повторить 
действие, чтобы было 
выбрано всего 7 индика-
торов. Разместить их, как 
показано на рис. 5.4.

2. Перейти в режим 
Block Diagram.

3. Из палитры Func-
tions выбрать генератор 
сигнала Simulate Signal 
(Express→Input→Simulate 
Signal). При этом появля-
ется окно настройки ге-
нератора (рис. 5.5). Пара-
метры взять из табл. 5.1. 
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Analysis→Filter). При этом появляется окно настройки фильтра (рис. 5.6). 
Параметры взять из табл. 5.2. Повторить действие, чтобы было выбрано 
всего 3 фильтра. Разместить их, как показано на рис. 5.4.

5. Из палитры Functions выбрать умножитель Multiply (Program-
ming→ Numeric→Multiply). Повторить действие, выбрав 3 умножите-
ля. Разместить их, как показано на рис. 5.4.

6. Из палитры Functions выбрать сумматор Add (Programming→ 
Numeric→Add). Повторить действие, выбрав 5 сумматоров. Разместить 
их, как показано на рис. 5.4.

Рис. 5.5. Окно настройки генератора

Таблица 5.1
Номер 
генератора

Параметры
Type Frequency (Hz) Phase Amplitude Duty cycle

1 Sine 9000 0 1 –
2 Sine 100 0 1 –
3 Sine 8000 0 1 –
4 Square 50 0 1 50
5 Sine 7000 0 1 –
6 Sawtooth 100 0 1 –

7. Из палитры Functions выбрать числовую константу Numeric 
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Constant (Programming→ Numeric→ Numeric Constant). Повторить 
действие, выбрав 3 константы. Разместить их, как показано на рис. 5.4. 
Ввести значение констант, равное 3.

Рис. 5.6. Окно настройки фильтра

Таблица 5.2
Номер
фильтра

Параметры
Filtering type Cutoff frequency Topology OrderLow High

1 Bandpass 8900 9100 Butterwort 3
2 Bandpass 7900 8100 Butterwort 3
3 Bandpass 6700 7300 Butterwort 3

8. Из палитры Tools выбрать монтажный инструмент «Катушку».
9. Соединить:
- выходы генераторов с номерами 1, 3, 5 со входами Х умножителей 

номеров  1, 2, 3 соответственно;
- выходы генераторов с номерами 2, 4, 6 со входами Х сумматоров 

номеров 1, 2, 3 соответственно;
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- числовые константы с номерами 1, 2, 3 со входами У сумматоров 
номеров 1, 2, 3 соответственно;

- выходы сумматоров с номерами 1, 2, 3 со входами У умножителей 
номеров  1, 2, 3 соответственно;

- выходы умножителей с номерами 1, 2, 3 со входами графических 
индикаторов номеров 1, 2, 3 соответственно;

- выходы фильтров с номерами 1, 2, 3 со входами графических ин-
дикаторов номеров 5, 6, 7 соответственно;

- вход У  сумматора 5 с проводом, соединяющим выход  умножите-
ля 3 и  графический индикатор 3;

- вход У  сумматора 4 с проводом, соединяющим выход  умножите-
ля 2 и  графический индикатор 2;

- вход Х  сумматора 4 с проводом, соединяющим выход  умножите-
ля 1 и  графический индикатор 1;

- выход  сумматора 4 со входом Х  сумматора 5;
- выход  сумматора 5 с  графическим индикатором 4;
- входы Signal фильтров с номерами 1, 2, 3 с проводом, соединяю-

щим выход  сумматора 5 и  графический индикатор 4.
10. Запустить работу ВП.
11. Получить сигналы, изображенные на рис. 5.7.

Рис. 5.7. Итоговая Front Panel

В лабораторном макете трехканальной СП с ЧРК для выполнения 
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эксперимента на входы каналов подаются сигналы с несущими разной 
частоты и модулирующими сигналами различного вида.

Задание
1. Изучить методы частотного разделения каналов.
2. Изучить  формирование канальных сигналов.
3. Создать структурную схему.
4. Пользуясь осциллографом, посмотреть осциллограммы в разных 

точках лабораторного макета трехканальной СП с ЧРК.
5. Изменяя  полосы пропускания фильтров, добиться наилучшей 

передачи канальных сигналов. Исследовать изменение вида осцилло-
грамм при изменении параметров сигналов и фильтров.

6. Обнулив один из канальных сигналов, оценить степень проник-
новения других канальных сигналов в его полосу.

7. Зарисовать полученные осциллограммы.

Содержание отчета
1. Краткая теория.
2. Структурная схема.
3. Осциллограммы.
4. Выводы.

Контрольные вопросы
1. В чем заключается принцип частотного разделения каналов?
2. Какие типы канальных сигналов используются в аналоговых СП?
3. Каковы достоинства и недостатки канального сигнала АМ ?
4. Как влияют линейные искажения в групповом тракте СП с ЧРК 

на передачу сигналов?
5. Преимущества и недостатки ЧРК.
6. Что предпринимают для снижения переходных помех?
7. Критерии сравнения типов канальных сигналов.
8. Какие допущения и идеализацию вводят для анализа искажений 

в системах с ЧРК?
9. Как изменяется выходной сигнал при изменении параметров ге-

нераторов?
10. Как работает функциональная схема, представленная на рис. 5.1?
11. Объяснить графики, представленные на рис. 5.2.
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12. Для чего вводятся защитные частотные интервалы?
13. Какие частоты гармонических колебаний используются в СП в 

качестве переносчиков?
14. Из-за чего возникают взаимные помехи между каналами?

Лабораторная работа № 6

ИЗУЧЕНИЕ ПРИНЦИПОВ ВРЕМЕННОГО РАЗДЕЛЕНИЯ 
СИГНАЛОВ

Цель работы
Изучение принципов построения многоканальных систем переда-

чи с временным  разделением каналов и влияния искажений в линей-
ных трактах на качество передачи сигналов. Исследование проводится 
с помощью виртуальной лабораторной установки.

Краткие теоретические сведения
Принцип временного разделения каналов (ВРК) состоит в том, что 

групповой тракт предоставляется поочередно для передачи сигналов 
каждого канала многоканальной системы (рис. 6.1). 

Рис. 6.1. Принцип временного разделения каналов

В зарубежных источниках для обозначения принципа временного 
разделения каналов используется термин Time Division Multiply Access 
(TDMA).

При передаче используется дискретизация во времени (импульсная 
модуляция). Сначала передается импульс 1-го канала, затем следующе-
го канала и т.д. до последнего канала за номером N, после чего опять 
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передается импульс 1-го канала и процесс повторяется периодически. 
На приеме устанавливается аналоговый коммутатор, который пооче-
редно подключает групповой тракт к соответствующим приемникам. В 
определенный короткий промежуток времени к групповой линии свя-
зи оказывается подключенной только одна пара приемник/передатчик. 

Это означает, что для нормальной работы многоканальной систе-

Рис. 6.2. Преобразование сигналов при ВРК

мы с ВРК необходи-
ма синхронная и син-
фазная работа комму-
таторов на приемной 
и передающей сторо-
нах. Для этого один из 
каналов занимают под 
передачу специальных 
импульсов синхрони-
зации.

На рис. 6.2 приве-
дены временные диа-
граммы, поясняющие 
принцип ВРК. На рис. 
6.2, а-в приведены гра-
фики трех непрерыв-
ных аналоговых сиг-
налов u1(t), u2(t) и u3(t) 
и соответствующие им 
сигналы с амплитудно-
импульсной модуля-
цией (АИМ). Импуль-
сы различных АИМ-
сигналов сдвинуты 
друг относительно дру-
га по времени. При объ-
единении индивидуаль-
ных каналов в канале 
(линии) связи образует-
ся групповой сигнал (рис. 6.2, г) с частотой следования импульсов в N раз 
большей частоты следования индивидуальных импульсов.
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 Интервал времени между ближайшими импульсами группового сиг-
нала называется канальным интервалом (ТК), или тайм-слотом (Time Slot). 
Промежуток времени между соседними импульсами одного индивидуаль-
ного сигнала называется циклом передачи (ТЦ). От соотношения ТЦ и TK 
зависит число импульсов, которое можно разместить в цикле, т.е. число 
временных каналов.

При временном разделении, так же как и при ЧРК, существуют 
взаимные помехи, в основном обусловленные двумя причинами. Пер-
вая причина состоит в том, что линейные искажения, возникающие 
за счет ограниченности полосы частот и неидеальности амплитудно-
частотной и фазочастотной характеристик всякой физически осуще-
ствимой системы связи, нарушают исходную импульсную форму сиг-
налов. При временном разделении сигналов это приведет к тому, что 
импульсы одного канала будут накладываться на импульсы других ка-
налов. Между каналами возникают взаимные переходные помехи, или 
межсимвольная интерференция. Кроме того, взаимные помехи могут 
возникать за счет несовершенства синхронизации тактовых импульсов 
на передающей и приемной сторонах.

В общем случае для снижения уровня взаимных помех приходится 
вводить «защитные» временные интервалы, что соответствует некото-
рому расширению спектра сигналов. Так, в СП полоса эффективно пе-
редаваемых частот F=3100 Гц; в соответствии с теоремой Котельнико-
ва минимальное значение частоты дискретизации f0=1/ТД=2F=6200 Гц. 
Однако в реальных системах частоту дискретизации выбирают с не-
которым запасом: f0=8 кГц. При временном разделении каналов сигнал 
каждого канала занимает одинаковую полосу частот, определяемую в 
идеальных условиях согласно теореме Котельникова из соотношения 
(без учета канала синхронизации) DtK=T0/N=1/(2NF)= 1/(2FОБЩ), где 
FОБЩ=FN, что совпадает с общей полосой частот системы при частот-
ном разделении. Хотя теоретически временное и частотное разделения 
позволяют получить одинаковую эффективность использования ча-
стотного спектра, тем не менее, системы временного разделения усту-
пают системам частотного разделения по этому показателю.

Вместе с тем системы с временным разделением имеют неоспори-
мое преимущество, связанное с тем, что благодаря разновременности 
передачи сигналов разных каналов отсутствуют переходные помехи 
нелинейного происхождения.
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Кроме того, аппаратура временного разделения значительно про-
ще, чем для частотного разделения, где для каждого индивидуального 
канала требуются соответствующие полосовые фильтры, которые до-
статочно трудно реализовать средствами микроэлектроники.

Создание лабораторной установки

1. В режиме Front Panel из палитры Controls выбрать  графический 
индикатор Waveform Graph для отображения сигнала и перенести его 
на лицевую панель (Modern→Graph→Waveform Graph). Повторить дей-
ствие, создав  7 индикаторов. Разместить их, как показано на рис. 6.3.

Рис. 6.3. Структурная схема установки

2. Из палитры Controls выбрать кнопку остановки Stop Button 
(Modern→Boolean→ Stop Button). Разместить, их как показано на рис. 6.3.

3. Перейти в режим Block Diagram.
4. Из палитры Functions выбрать генератор сигнала Simulate Sig-

nal (Express→Input→Simulate Signal). При этом появляется окно на-
стройки генератора (рис. 6.4). Параметры взять из табл. 6.1. Повторить 
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действие, чтобы было выбрано всего 9 генераторов. Разместить их, как 
показано на рис. 6.3.

Рис. 6.4. Окно настройки генератора

Multiply (Programming→ 
Numeric→Multiply). По-
вторить действие, выбрав 9 
умножителей. Разместить их, 
как показано на рис. 6.3.

7. Из палитры Functions 
выбрать математическую 
функцию Increment (+1) 
(Programming→Numeric→ 
Increment). Повторить дей-
ствие, выбрав 6 шт. Разме-
стить их, как показано на 
рис. 6.3.

5. Из палитры Func-
tions выбрать фильтр Fil-
ter (Express→Signal Analy-
sis→Filter). При этом по-
является окно настрой-
ки фильтра (рис. 6.5). Па-
раметры фильтра взять 
из табл. 2. Повторить дей-
ствие, выбрав 3 фильтра. 
Разместить их, как показа-
но на рис. 6.3.

6. Из палитры Func-
tions выбрать умножитель 

Рис. 6.5. Окно настройки фильтра
Таблица 6.1

Номер
генератора

Параметры
Type Frequency (Hz) Phase Amplitude Duty cycle

1 Square 18 0 1 50
2 Square 320 0 1 18
3 Sine 18 0 1 50
4 Square 320 120 1 18
5 Sawtooth 18 0 1 50
6 Square 320 240 1 18
7 Square 320 0 1 18
8 Square 320 120 1 18
9 Square 320 240 1 18
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8. Из палитры Functions выбрать сумматор Add (Programming→ 
Numeric→Add). Повторить действие, выбрав 2 сумматора. Разместить 
их, как показано на рис. 6.3.

9. Из палитры Functions выбрать делитель Divile (Programming→ 
Numeric→Divile). Повторить действие, выбрав 3 делителя. Разместить 
их, как показано на рис. 6.3. Параметры взять из табл. 6.2.

Таблица 6.2
Номер
фильтра

Параметры
Filtering type Cutoff frequency Topology Order

1 Lowpass 100 Bessel 25
2 Lowpass 100 Bessel 25
3 Lowpass 100 Bessel 25

10. Из палитры Functions выбрать числовую константу Numeric 
Constant (Programming→Numeric→Numeric Constant). Повторить дей-
ствие, выбрав 6 констант. Разместить их, как показано на рис. 6.3. Вве-
сти значение констант: 1-, 2-, 3-й, равное 2; 4-, 5-, 6-й, равное 5.

11. Из палитры Tools выберите монтажный инструмент «Катушку».
12. Соединить:
- выходы генераторов с номерами 1, 3, 5 со входами Х 1-, 2-, 3-го 

умножителей соответственно:
- выходы генераторов с номерами 2, 4, 6, 7, 8, 9 со входами Х мате-

матических функций Increment номеров 1, 2, 3, 4, 5, 6 соответственно;
- выходы математических функций Increment с номерами 1, 2, 3, 4, 

5, 6 с входами У умножителей номеров 1, 2, 3, 4, 5, 6 соответственно;
- выходы умножителей с номерами 1, 2, 3, 7, 8, 9 со входами  графи-

ческих индикаторов номеров 1, 2, 3, 5, 6, 7 соответственно; 
- выходы умножителей с номерами 4, 5, 6 со входами Х делителей  

номеров 1, 2, 3 соответственно;
- числовые константы с номерами 1, 2, 3 со входами У делителей 

номеров 1, 2, 3 соответственно;
- числовые константы с номерами 4, 5, 6 со входами У умножите-

лей  номеров 7, 8, 9 соответственно;
- выходы делителей с номерами 1, 2, 3 со входами Signal фильтров 

номеров  1, 2, 3 соответственно;
- выходы фильтров с номерами 1, 2, 3 со входами У умножителей 

номеров  7, 8, 9 соответственно;
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- вход Х 1-го сумматора с проводом, соединяющим выход  1-го 
умножителя  и 1-й графический индикатор;

- входы У сумматоров с номерами 1, 2 с проводами, соединяющими 
выходы умножителей и  графические индикаторы номеров 2, 3 соот-
ветственно;

- выход 1-го сумматора со входом Х 2-го сумматора;
- выход 2-го сумматора с  графическим индикатором 4;
- входы Х умножителей с номерами 4, 5, 6 с проводом, соединяю-

щим выход 2-го сумматора и  графический индикатор 4.
13. Из палитры Functions выбрать While Loop (Programming→ 

Structures→ While Loop). Выделить всю схему. Соединить кнопку оста-
новки и Loop Condition.

14. Настроить анализаторы по примеру (правая кнопка мыши→ x 
Scale→Formatting):

15. Запустить работу виртуального прибора. 
16. Остановить нажатием на кнопку остановки Stop Button. Полу-

чить изображение сигналов согласно рис. 6.6.

Рис. 6.6. Итоговая Front Panel

Задание
1. Создать структурную схему.
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2. Произвести настройку параметров элементов.
3. Пронаблюдать и сравнить форму принятых сигналов с формой 

модулирующих.
4. Изменить параметры сигналов и фильтров и пронаблюдать ре-

зультаты изменений.
5. Зарисовать полученные осциллограммы.

Содержание отчета
1. Краткая теория.
2. Структурная схема.
3. Осциллограммы.
4. Выводы.

Контрольные вопросы
1. В чем заключается принцип временного разделения каналов?
2. Охарактеризуйте методы модуляции при ВРК (АИМ, ШИМ, ФИМ).
3. Назовите причины возникновения искажений.
4. Как влияют линейные искажения в групповом тракте с ВРК на 

передачу сигналов?
5. Как влияют нелинейные искажения в групповом тракте с ВРК на 

передачу сигналов?
6. Зачем в СП с ВРК применяется синхронизация?
7. Что такое тайм-слот?
8. Что называется циклом передачи?
9. От чего зависит число временных каналов?

10. Преимущества систем с ВР.
11. Недостатки систем с ВР.
12. Как изменяется выходной сигнал при изменении параметров ге-

нераторов?
13. Как изменяется выходной сигнал при изменении параметров 

фильтров?
14. Что необходимо для работы многоканальной системы с ВРК?
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